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CHAPTER 1 Introduction
Information provided in this guide applies equally to Websense Enterprise® 
and Websense® Web Security Suite™. Any information that pertains 
specifically to 1 of these products is noted separately.

The same software is installed for these products, but the Web Security Suite 
features are enabled only if you enter a Web Security Suite subscription key.

The following topics introduce Websense Enterprise Reporter.

How Websense Enterprise Reporter works
Categories
Risk Classes

How Websense Enterprise Reporter works

Websense Enterprise gives an organization the ability to monitor and control 
the way the Internet is used.

Websense Enterprise Reporter provides reports about actual or attempted 
Internet activity.

There are many components that work together in Websense Enterprise and 
Websense Enterprise Reporter. If you are running reports (and not 
administering the system), these are the only components that you need to 
know about:

Log Database - the center of Reporting
Reporter
Reporter’s Application window

Note
Your reports may vary from the samples shown in this 
guide. Follow the documentation to learn how to create or 
modify your reports.
Reporter User Guide X 5



Chapter 1: Introduction
Log Database - the center of Reporting
Websense Enterprise sends information to Websense Enterprise Reporting 
about Internet activity. This activity is stored in the Log Database, which 
encompasses the Catalog Database (created at installation) and database 
partitions for reporting.

Information in the Log Database answers questions like:

Who accessed the Internet?
Who was blocked from accessing the Internet?
At what time?
What URL was accessed?
How is that site categorized?
How much time was spent online?
What protocol was used?
6 W Websense Enterprise Reporting
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Reporter
Reporter is installed on the machine where reports will be run or scheduled to 
be run.

Reporter displays reports based on specific templates. Select a report type, 
filter criteria, and then generate a report.

Each of the Reporter report types comes in a variety of formats. Reports of 
any type vary, based on the selected format and report criteria. Several charts 
present only those objects with the longest duration or the highest number of 
hits or bytes transferred (bandwidth used).
Reporter User Guide X 7
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Reporter’s Application window
Reporter uses the Windows print preview capability to display reports.

Make sure that a default print driver is installed on your system, and that it is 
the appropriate driver for the operating system, before attempting to generate 
or print reports. The machine does not need a printer connected, but it must 
have a print driver installed.

If a default print driver is installed and Reporter is still having problems, then 
install another print driver for the Reporter program to use. After doing that, 
go to File > Print Setup in Websense Reporter and select the newly-installed 
printer from the drop-down list. 
The Reporter Application Window looks like this.

There are over 80 different report formats, divided by type into:

Trend
Management
8 W Websense Enterprise Reporting
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Detail
Summary

The Reporter window displays 2 separate panes. Select a report type in the left 
(Workspace) pane. View and work with the generated report in the right 
(Report) pane.

In addition, the Reporter window contains 2 toolbars that allow quick access 
to frequently used functions:

The main toolbar lies directly under the main menu.
The Report pane toolbar appears at the top of each generated report.

Workspace pane
The Workspace pane contains a topic tree with folders listing available report 
formats by type and information presented. Double-click a folder to open it, 
and then double-click the report format you want to use.

You can resize the Workspace pane for easy viewing of the report formats 
available for generation. Change the size of the pane by dragging the edges 
with the mouse, or hold down the left mouse button over the double lines and 
drag it.
Reporter User Guide X 9
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Remove the pane entirely by unchecking Workspace in the View menu, or 
clicking x in the upper right corner of the Workspace pane. To restore the 
Workspace pane, check Workspace in the View menu.
10 W Websense Enterprise Reporting
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Report pane
Reporter displays a generated report in the Report pane. In most cases, the 
size of the report exceeds the application window. Adjust the scroll bars to 
move different parts of the page into view. Use the buttons on the toolbar to 
view a different report page.

Increase the size of the Report pane by minimizing or eliminating the 
Workspace pane, and by increasing the size of the entire Reporter window. 
Numerous reports can be open in the pane at the same time. Select Cascade or 
Tile from the Window menu to organize the reports differently, so you can 
see which reports are open.
Reporter User Guide X 11
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Categories

The Websense Enterprise Master Database is downloaded for your use on a 
regular basis. This Master Database includes millions of URLS that have been 
classified into approximately 100 categories.

Websense does not make value judgments with regard to the categories or 
sites within the Websense Master Database. The categories have been selected 
based on feedback from the business and education communities regarding 
what would be deemed unacceptable, inappropriate, or undesirable in a 
business or school setting with regard to employee productivity, student 
safety, or threat of legal action. 

The category list defines each Websense category. You select which 
categories to block and which to permit, based on the needs of your 
organization. Because of the changing nature of the Internet, category 
definitions may be altered and new categories added to provide the most 
complete Master Database possible. For the most up-to-date list of categories, 
see the Category List Web page at: 

http://www.websense.com/products/about/database/categories.cfm

Risk Classes

To help you identify the risks to your organization from activity in these 
categories, Websense also maps categories into Risk Classes.

These Risk Classes are:

Productivity Loss
Network Bandwidth Loss
Business Usage
Security Risk
Legal Liability

For specifics on how Risk Classes are mapped to categories, see Appendix A: 
Risk Classes .

The Websense Administrator can change this mapping in Websense Manager. 
If changes are made in the mapping, Reporter reports will reflect activity as 
defined in these customized Risk Classes.
12 W Websense Enterprise Reporting
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Chapter 1: Introduction
Online Help

Select the Help option within the program to display detailed information 
about using the product.

If Microsoft® Internet Explorer is your browser, the default settings may block 
operation of the Help system. If a security alert appears, select Allow Blocked 
Content to display the Help.

If corporate security standards permit, you can permanently disable the 
warning message in Internet Explorer. Go to Tools > Internet Options > 
Advanced tab > Security, and check Allow active content to run in files on 
My Computer.

Technical Support

Technical information about Websense products is available online 24 hours a 
day, including:

latest release information
searchable Websense Knowledge Base 
show-me tutorials
product documents
tips
in-depth technical papers

Access support on the Web site at:

   www.websense.com/SupportPortal/

For additional questions, fill out the online support form at:

   www.websense.com/SupportPortal/Contact.aspx

If your issue is urgent, please call one of the offices listed below. You will be 
routed to the first available technician, who will gladly assist you.
Reporter User Guide X 13
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For telephone requests, please have ready:

Websense subscription key
Access to Websense Manager
Access to the machine running Filtering Service, the machine running 
reporting tools, and the database server (Microsoft SQL Server or MSDE)
Permission to access the Websense Log Database
Familiarity with your network’s architecture, or access to a specialist
Specifications of machines running Filtering Service and Websense 
Manager
A list of other applications running on the Filtering Service machine

Location Contact information

North America +1  858-458-2940 

France Contact your Websense Reseller. If you cannot 
locate your Reseller: +33 1573 232 27

Germany Contact your Websense Reseller. If you cannot 
locate your Reseller: +49 6951 709 347

UK Contact your Websense Reseller. If you cannot 
locate your Reseller: +44 (0) 2030 244 401

Rest of Europe Contact your Websense Reseller. If you cannot 
locate your Reseller: +44 (0) 2030 244 401

Middle East Contact your Websense Reseller. If you cannot 
locate your Reseller: +44 (0) 2030 244 401

Africa Contact your Websense Reseller. If you cannot 
locate your Reseller: +44 (0) 2030 244 401

Australia/NZ Contact your Websense Reseller. If you cannot 
locate your Reseller: 1-800-881-011,  Access Code 
800-542-8609

Asia Contact your Websense Reseller. If you cannot 
locate your Reseller: +86 (10) 5884-4200

Latin America
and Caribbean

Contact your Websense Reseller.
14 W Websense Enterprise Reporting
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Overview of running Reporter reports
Choosing report criteria
Formats and descriptions of Reporter reports
Column descriptions in Reporter
Working with Internet Browse Time reports in Reporter
Running reports from the command line in Reporter
Generating Favorites
Examples of Reporter reports

Overview of running Reporter reports

Reporter uses the Windows print preview capability to display reports. Make 
sure that a default print driver is installed on your system, and that it is the 
appropriate driver for the operating system, before attempting to generate or 
print reports. The machine does not need a printer connected, but it must have 
a print driver installed.

If a default print driver is installed and Reporter is still having problems, then 
install another print driver for Reporter to use. After doing that, go to File > 
Print Setup in Websense Reporter and select the newly-installed printer from 
the drop-down list.

Note
Because the Log Database contains Internet activity for 
every employee, it can grow quite large. Depending on 
your machine, reports with large volumes of results to 
display may take a long time. Try to narrow the report as 
much as possible by selecting specific report criteria 
before generating it.
Reporter User Guide X 15
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1. Log on to Websense Reporter from the Windows Start menu: Programs 
> Websense > Websense Reporter.

2. Select a type of report and a specific report from 1 of the folders. The 
Report Criteria icon appears in the top menu.

3. Click Report Criteria in the top menu. The Report Criteria dialog box 
appears, containing tabs with settings for a date range, lists of available 
protocols, dispositions, categories or Risk Classes, users or groups, 
destinations, and various customizable features such as header and logo 
selection. For more information, see Choosing report criteria, page 17.

4. Select a tab to display its options.

5. After establishing criteria for a particular report, save the settings for 
future use by clicking Save as Favorite on the Report Criteria dialog box 
before generating the report.

6. Click Generate to create the report. Reporter evaluates the Log Database 
to identify entries that meet all selected report criteria. Combine report 
criteria selections carefully to avoid defining an empty report. 
16 W Websense Enterprise Reporting
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Choosing report criteria

In the Report Criteria dialog box select individual categories to be reported, as 
well as specific users, groups, or IP addresses. The Categories/Risk Classes 
tab lists all categories in the Websense Master Database, as well as any 
custom categories created via Websense Manager.

During startup, the Reporter application checks the Log Database for changes, 
and updates the categories. This assures that the latest information is available 
in the Report Criteria dialog box. 

Click View > Refresh or press F5 to quickly update the lists without 
closing and restarting Reporter.

After setting criteria for all tabs, click Save as Favorite to save the 
settings for later use, and then click Generate to create the report.

Dates tab (or Trend Dates tab)
Use the Dates tab (or Trend Dates tab for Trend reports) to indicate what time 
period you would like the report to cover. Reporter combines date selections 
with other report criteria to determine the Internet activity reported.

Note
Close the Report Criteria window when refreshing 
database information.
Reporter User Guide X 17



Chapter 2: Running Reports in Reporter
All reports will show the Dates tab, with the exception of the Trend reports. 
The Trend reports will display the Trend Dates tab.

Select the Reporting Dates or Week/Month Range using 1 of the following 
methods.

All Dates check box: This option is selected by default, indicating that all 
dates in the Log Database will be considered for the report. Uncheck this 
option to select a specific time period.
Buttons on Dates tab: Click a button under the calendars to set a date 
range. Today and Yesterday buttons report information for the current or 
previous system date. This Week and Last Week buttons report 
information for a 7-day period from Sunday to Saturday. This Month and 
Last Month buttons report on the selected calendar month. 
Buttons on Trend Dates tab: Click a button under the calendars to set a 
date range. This Week reports information on the trend for the current 
week. The Last Month button reports information on the trend during the 
past month. The Last 3, 6, 12, or 24 Months buttons report information on 
the trends during those periods. 
18 W Websense Enterprise Reporting
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From and To fields: Select the report’s beginning and ending dates in 
these fields. Click 1 of the buttons, and the appropriate dates display in 
the From and To fields.
Calendars: Select a date on the calendar below the From field to select a 
start date. Select a date on the calendar below the To field to select an end 
date.

The date and time formats shown in reports reflect the Regional Settings 
established in the Windows Control Panel. For more information on changing 
date and time formats, see the Windows documentation.

Protocols tab
Use the Protocols tab to select the protocols you want to report on. Reporter 
combines protocol selections with other report criteria to determine the 
Internet activity reported.

The Protocols tab lists the protocols represented in the Websense Master 
Database. However, many Websense integration partners support URL 
filtering for only a limited number of protocols. Reporter can only generate 
reports for the protocols represented in the Log Database. To get a list of 

Note
When generating reports at the command line or through 
the Scheduled Jobs feature, date settings made in the 
Report Criteria dialog box are not used.
Reporter User Guide X 19



Chapter 2: Running Reports in Reporter
protocols that your integration product supports, see the Websense Enterprise 
Installation Guide specific to your integration.

Check each protocol to be reported. The report omits Internet requests 
through any unchecked protocol. If nothing is selected when you click 
Generate, a message appears, asking if you would like all protocols to be 
included in the report.

Dispositions tab
Websense analyzes each URL request it receives to determine its proper 
disposition. The disposition represents the exact reason the request was 
permitted or blocked. Use the Dispositions tab to select the dispositions to be 
20 W Websense Enterprise Reporting
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reported. Reporter combines disposition selections with other report criteria to 
determine the Internet activity reported.

Check the dispositions you want to include in the report. Any unchecked 
dispositions will be omitted. If nothing is selected when you click Generate, 
a message appears, asking if you would like all dispositions to be included in 
the report. Information on each selected disposition will be considered and 
used if compliant with settings on the other tabs.

Categories/Risk Classes tab
The Categories/Risk Classes tab lets you select either the categories or the 
Risk Classes to be reported. Reporter combines selections with other report 
criteria to determine the Internet activity reported.

When you open the Reporter window, Reporter retrieves the current 
Categories/Risk Classes list from the Log Database. 

On the Categories/Risk Classes tab, check the categories or Risk Classes to be 
reported. If nothing is selected when you click Generate, a message appears, 
asking if you would like all categories or all Risk Classes (depending on your 
selection) to be included in the report. 
Reporter User Guide X 21
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Select by category
The categories in this list come directly from Websense, allowing you to 
report both the predefined categories contained in the Master Database, and 
any custom categories you create in Websense.

If WebCatcher is enabled and a site has been identified as possibly containing 
adult material, a special Potential Adult Material category appears in this list.

Log Server periodically reads the current Websense category list and stores it 
in the Log Database.
22 W Websense Enterprise Reporting
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Select by Risk Class
The Risk Classes in this list come directly from Websense, allowing you to 
report activity based on the Risk Classes for Websense Enterprise.

Categories in the Websense Master Database are classified into groups known 
as Risk Classes. Risk Classes help to classify Websense categories into more 
measurable groupings and help you measure how employees’ Internet usage 
can be classified into levels of risk.

Risk Classes include: 

Legal Liability
Network Bandwidth Loss
Security Risk
Productivity Loss
Business Usage.

Appendix A: Risk Classes shows the default mapping between Risk Classes 
and categories. This mapping can be modified in Websense Manager.
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Users/Groups tab
The Users/Groups tab allows you to search for and select specific users, 
groups, and workstations to be reported. Reporter combines user/group 
selections with other report criteria to determine the Internet activity reported.

User/Group Search: Search for a specific user or group.
a. Select a search type from the drop-down box, or enter the name or a 

portion of the name of a user or group in the Search box to refine your 
search.

b. Click Search to retrieve information from the Log Database:
Limit search: Limit your search to a specific number of entries to be 
displayed in the Current Users/Groups field.
24 W Websense Enterprise Reporting
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Load users with groups: This option is available when you have 
searched for a group and want to include all users associated with the 
selected group. The users are included by logon name in the tree 
search results displayed in Current Users/Groups.

Current Users/Groups: Lists the users (by logon name) or groups that 
you have selected from the Log Database. If all users are included for the 
selected group, user logon names are included in the tree search results 
displayed in this list.
Report on: Lists users and groups you have already selected for the 
report.
a. Select a user, group, or workstation in the Current Users/Groups list.
b. Click the right arrow button to include your selection in the report or 

click the left arrow button to move it out of your report (< or >).
c. To move all users, groups, and workstations from 1 list to the other, 

click the appropriate double arrow button (<< or >>). 
If nothing is moved from Current Users/Groups to Report on, then all 
users and groups within your Log Database will default to Report on.

IMPORTANT
Enabling the Load users with groups option will cause the 
search to take longer.

If all users are included with your selected group, be aware 
that a group containing more than 10,000 users will 
generate an error and the report will stop running.

Note
If assigned to more than one group, a user’s log 
information is reported with every selected group to which 
that user belongs. This duplication could inflate totals on 
group-oriented reports.
Reporter User Guide X 25
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Destinations tab
The Destinations tab allows you to add up to 10 URL domain names to use as 
additional report criteria. (Partial paths are not supported.)

Type the destination URLs that interest you for your reporting by clicking 
Add.
26 W Websense Enterprise Reporting
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Customize tab
The Customize tab provides options for tailoring individual reports to suit 
your needs.

Report Title: Enter a title of up to 2 lines for the report, or accept the 
default. The report title is centered at the top of the report.
Logo: Check Include Logo to include a graphic in the upper left corner of 
the report. Enter the complete path and file name of the graphic you want 
to insert (by default, the Websense Enterprise Reporter logo appears on 
each report) in the File Name field. 

Note
The graphic must be a bitmap (.bmp) file of no more than 
16 colors and no larger than 180 x 80 pixels.

The .bmp of the logo does not need to reside on the same 
machine as long as you are using a mapped drive or a 
Universal Naming Convention (UNC).
Reporter User Guide X 27
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Uncheck the Include Logo option to omit any graphic from appearing on 
the report. 
Cost Variable: Available only if the selected report contains cost 
information, use this field for reports that calculate the cost of Internet 
usage. The default value of this field is 0. For Internet Browse Time 
reports, enter the cost of Internet usage per hour, per user. For non- 
Internet Browse Time reports, enter the total cost of Internet usage for all 
reported users during the time period of the report.
Based on this cost variable and information from the Log Database, 
Reporter uses the following formulas to produce a cost figure for each 
client (user, group, or workstation). Calculations vary, depending on the 
report format.

Internet Browse Time reports: Internet Browse Time reports 
calculate the cost of the time spent accessing the Internet by using the 
following formula: Enter the total cost of Internet usage for all 
reported users during the time period of the report.
Client total of Internet browse time for user or 
group x Cost Variable = individual cost

Non-Internet Browse Time reports with cost information: All 
other reports that provide cost information use the following formula:
Client total of bytes transferred /Grand total of 
bytes transferred = % Percentage derived above x 
Cost Variable = individual cost

Report Only: Available only for top reports (such as Top Groups by 
Bytes Transferred), this field lets you set the number of objects to be 
reported. The default is the top 10 objects. The type of object reported 
may be categories, destinations, groups, or users, depending on the report 
format selected.
Read Time Threshold (default 3 minutes): Available only if the report 
contains Internet Browse Time information. There is no way to determine 
what a user does (such as, looks at the Web page, talks to a co-worker, or 

Note
All cost figures are calculated using 1 of these formulas 
and reported values are rounded. Consequently, Total Cost 
figures may be a few cents more than the sum of the 
individual line items in the report.
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reads work-related print material) once a Web page has been accessed. 
Specify the read time to be used when calculating browse time. The Read 
Time Threshold is used by Websense to determine when 1 session ends 
and another starts.

Formats and descriptions of Reporter reports

Reporter organizes these reports into the following types:

Trend reports: Show data collected over time. These reports are 
calculated by the Daily Job query that is set up in the Log Server 
Configuration program. 
Management reports: Comprise frequently used big picture reports or 
those potentially of most interest to management. 
Detail reports: Provide specific information on the sites requested and 
the employees who requested them. Information includes every site or 
category for each user and protocol selected. Dates and times can also be 
provided for a more complete picture of Internet access.
Summary views: Give an overview of Internet usage for selected 
categories, destinations, groups, protocols, and users. Totals are provided 
for hits and bytes transferred, depending upon the report format selected.

Look at the following table to determine the type of report you would like. 
Select a format by double-clicking the report format name in the topic tree. 
Then, set report criteria in the dialog box that appears.

Type Folder Report Format and Description

TREND Disposition Hits Line chart
Table
All users, percentage change

Internet Browse 
Time

Internet Browse Time Line chart
Table
All users, percentage change

Protocol Bandwidth Line chart
Table 
All users, percentage change
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Hits Line chart
Table 
All users, percentage change

Risk Permitted Hits Line chart
Table 
All users, percentage change

MANAGEMENT Category Internet Browse Time Table 

Top by Blocked 
Access

Table 
Bar chart

Top by Bytes 
Transferred

Table 
Bar chart

Top by Hits Table 
Bar chart

Top by Internet 
Browse Time

Table 
Bar chart

Bytes Transferred Table 
Bar chart

Hits Table 

Destination Internet Browse Time Table 

Top by Blocked 
Access

Table 
Bar chart

Top by Bytes 
Transferred

Table 
Bar chart

Top by Duration Table 
Bar chart

Top by Hits Table 
Bar chart

Top by Internet 
Browse Time

Table 
Bar chart

Disposition Occurrences Table 
Bar chart

Type Folder Report Format and Description
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File Type Bandwidth Table 
Pie chart

File Accesses Table
Pie chart

Group Activity Detail Table

Bandwidth Summary Table

Destination Summary Table

Internet Browse Time 
Detail

Table

Internet Browse Time 
Summary

Table

Protocol Detail Table

Protocol Summary Table

Top by Blocked 
Access

Table
Bar chart

Top by Bytes 
Transferred

Table
Bar chart

Top by Hits Table
Bar chart

Top by Internet 
Browse Time

Table
Bar chart

Protocol Bandwidth Analysis Table
Pie chart

Hit Analysis Table
Pie chart

Top by Blocked 
Access

Table
Bar chart

Bytes Transferred Table
Bar chart

Risk Corporate Risk Table
Bar chart

Type Folder Report Format and Description
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User Activity Detail Table

Bandwidth Summary Table

Destination Summary Table

Internet Browse Time 
Detail

Table

Internet Browse Time 
Summary

Table

Protocol Detail Table

Protocol Summary Table

Top by Blocked 
Access

Table
Bar chart

Top by Bytes 
Transferred

Table
Bar chart

Top by Hits Table
Bar chart

Top by Internet 
Browse Time

Table
Bar chart

(not a folder)
Monthly 
Summary Report

5 reports
5 tables
2 pie charts
1 line chart

(not a folder)
Total Internet 
Browse Time

Table

DETAIL Category Bytes Transferred Table

Full URL 
Destinations by Date

Table

Groups Table

Users Table

Group Bytes Transferred Table

Destinations Table

Type Folder Report Format and Description
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Protocol Bytes Transferred Table

Bytes Transferred by 
Date

Table

User Bytes Transferred Table

Destinations Table

SUMMARY Category Bytes Transferred Table

Bytes Transferred by 
Date

Table

Destination Top by Bytes 
Transferred

Table

Top by Bytes 
Transferred and 
Category

Table

Top by Date and 
Duration

Table

Top by Duration Table

Top by Hits Table

Top by User Table

Group Bytes Transferred Table

Bytes Transferred by 
Date

Table

Bytes Transferred by 
Date with Cost

Table

Categories by Date Table

Destinations Table

Destinations by Date Table

Destinations by Time 
of Day

Table

Protocol Bytes Transferred Table

Bytes Transferred by 
Date

Table

User Bytes Transferred Table

Type Folder Report Format and Description
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Formats of Reporter reports
The available formats for Reporter reports are:

Line charts
Table report
Bar chart
Pie chart

Bytes Transferred by 
Date

Table

Bytes Transferred by 
Date with Cost

Table

Categories by Date Table

Destinations Table

Destinations by Date Table

Destinations by Time 
of Day

Table

Type Folder Report Format and Description
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Line charts
This report displays Disposition Trends for Blocked, Permitted, Quota 
Bandwidth, and Quota Time
Reporter User Guide X 35



Chapter 2: Running Reports in Reporter
Table report
This report displays the Summary of Internet Browse Time by Category.
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Bar chart
This report displays the top categories blocked from accessing the Internet.
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Pie chart
This report displays an analysis of bandwidth usage.

Column descriptions in Reporter

Depending upon the report format you select, the generated report may 
contain one or more of the columns described below.

Bytes Transferred: Information that occupies a certain number of bytes 
on the computer including bandwidth used, which comprises bytes sent 
and bytes received. When a user sends a request to a permitted site and 
receives information in the form of text and graphics from that site, the 
Bytes Transferred column identifies the total number of bytes transferred. 
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(A large amount of bytes will be sent where spyware is involved.) Bytes 
transferred equals bytes sent plus bytes received.

Category: Lists the predefined major topics contained in the Websense 
Master Database, and any custom categories you create in Websense.
In addition to the categories that can be set for filtering in Websense 
Manager, there are 2 additional categories that may appear on reports.
One category is Non-HTTP. This category will contain information about 
protocols other than HTTP. Examples of non-HTTP protocols include 
ICQ and RTSP.
The other category is Potential Adult Material.   This category may show 
up on reports, if it is enabled on the WebCatcher tab of the Log Server 
Configuration window. It is used by Websense WebCatcher to collect 
URLs that are possibly Adult Material. These URLs can be used for 
reporting or can be sent to Websense for further analysis, or both.
Cost: Cost is determined by Reporter based on information from the Log 
Database and the cost variable entered on the Customize tab in the Report 
Criteria dialog box. 
Date: Includes the month, day, and year the request was logged. Reporter 
uses the same date format that you select in the Regional Settings in the 
Windows Control Panel. For information on changing the date format in 
Regional Settings, see the Windows documentation.
Date/Session #/Time: Includes the month, day, and year that the request 
was logged, as well as the session number and time. 
Session # refers to the sequential numbering of Internet Browse Time 
sessions. Sessions are created each time the time difference between hits 
exceeds the Read Time Threshold.
Reporter uses the same date and time formats that you have selected in the 
Regional Settings in the Windows Control Panel. Reporter updates the 

Note
While Websense receives bytes transferred information 
from most integration partners, Check Point FireWall-1, 
Cisco Cache Engine, and Cisco Secure PIX Firewall do 
not currently send this information to Websense. Consider 
using Hits reports as an alternative.
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formats it uses when you change the date and time formats in Regional 
Settings.
Date/Time: Includes the month, day, and year that the request was 
logged, as well as the time. Reporter uses the same date and time formats 
that you have selected in the Regional Settings in the Windows Control 
Panel.
Destination IP: The numeric IP address of the site requested.
Domain name: The name of a website, such as www.websense.com.
Domain/User: The name of the domain to which the user belongs, and 
the full name of the user who requested the site. The users recorded by the 
Log Server are imported from Websense along with other log data. User 
information must be available to Websense in order to create user reports. 
Group information is not given on user-based reports.
Duration: The total time, in seconds, that it took to retrieve the HTML 
data and images from the actual site. This does not include time spent 
viewing the site once it has been completely loaded onto the user's 
machine.
Group: The Log Server records groups imported from Websense along 
with other log data. This column indicates the name of the group to which 
the requesting user belongs. Individual user names are not given on 
group-based reports. If directory service assigns a user to more than 1 
group, it reports Internet requests logged for that user in each assigned 
group.
Hits: A hit is a request for 1 URL. A Web page contains multiple 
elements, each having its own URL. Requesting the URL for the overall 
page generates requests for each component that makes up the page.
Log files can record each of these URL requests separately. As a result, 
log files may show multiple hits even when only 1 page was accessed.
Log Server can log hits or visits. Logging visits records the URL 
requested, while logging hits records many different files when 1 URL is 
requested.
However, when Websense blocks a site, it logs only the URL that was 
initially requested. As a result, the number of hits shown on reports of 
permitted sites appears inflated when compared with reports of blocked 
sites. Hits are also used in measuring time spent browsing the Internet. 
The information collected is included in Internet Browse Time reports.
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Internet Browse Time: Shows the time spent browsing a URL. The time 
is calculated from the time a hit is made, until the time another hit is made 
within the Read Time Threshold. The time is shown in the format, 
HH:MM:SS (hours, minutes, and seconds).
Protocol: Shows the protocol of the requested site. A protocol is a set of 
standards designed to enable computers to connect with one another and 
to exchange information. Protocols supported by Websense include 
HTTP, HTTPS, FTP, Gopher, NNTP, Telnet, IRC, and RealAudio. Not 
every integration partner supports all protocols. Check Websense 
Enterprise documentation for a list of protocols your integration product 
supports.
Source IP: This is the IP address of the machine from which the Internet 
request was made.
URL: The URL gives the domain name of the site requested. Depending 
upon settings established in the Log Server Configuration window, you 
may be able to generate a report of the full URL, which includes the 
domain name and the path to a specific page in that domain.
User: The name of the user who made the request. The users recorded by 
the Log Server are imported from Websense along with other log data. 
User information must be available to Websense for reporting user 
information. Group information is not given on user-based reports.

Working with Internet Browse Time reports in Reporter

Internet Browse Time reports in Reporter are a unique subset of Management 
reports. These reports calculate the time users spend accessing the Internet 
and can include details about the time spent at each site and the cost 
associated with Internet browsing. Internet Browse Time is calculated using a 
special algorithm, and certain reports include a cost variable that your 
organization can edit.

Note
Internet Browse Time reports may not include all users or 
group information at the time of generation. Press F5 often 
to make sure that user or group information is available to 
Reporter.
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Internet Browse Time reports in Reporter have features, calculations, and 
behavior that are different from other Reporter reports. These include:

Read Time Threshold and sessions
Reporting on users and groups with the same user ID
Calculation of browse time cost
Top N
Ads and miscellaneous sites not included

IMPORTANT
Do not enable caching at the integration level if you plan 
to generate Internet Browse Time reports in Reporter. Be 
aware the consolidation feature on the Consolidation tab in 
Log Server or enabling integration-level caching may 
skew the accuracy of the Reporter report calculations.
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Read Time Threshold and sessions
Because it is difficult to determine whether the user is actually reading the 
page, performing another task, or is away from his desk entirely between 
requests, Reporter uses the Read Time Threshold as the basis for measuring 
browse time. Reporter determines the browse time for users by measuring 
specific points in time and associating them with page requests made to the 
Internet. The threshold is the number of minutes after which a new browsing 
session is defined.

A new session is defined each time an initial page request is made of a unique 
top-level domain, such as www.sports.com, or when the Read Time Threshold 
is exceeded between requests.

For example, with the Read Time Threshold set to 3 minutes, an employee 
goes to www.cnn.com. If a request is made to www.google.com 2 minutes 
after the initial request to www.cnn.com, 2 minutes of browse time are 
assigned to cnn.com. A subsequent request to www.msn.com 4 minutes later 
will assign 3 minutes to google.com and begin a new session for msn.com.

The Read Time Threshold is added to the end of each session. Read Time 
Threshold is set in the Customize tab of the Report Criteria dialog box. The 
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default value is 3 minutes. Change this value to suit your organization’s 
Internet usage patterns.

Reporting on users and groups with the same user ID
When multiple users share the same user name identification (user ID) when 
logging on, the data reflected on Internet Browse Time reports is cumulative 
for all users with that same user ID.

Calculation of browse time cost
In the case of Internet Browse Time reports, the value in the Cost Variable 
area of the Customize tab is interpreted as a cost of bandwidth per user, per 
hour. Internet Browse Time reports calculate the cost of the time spent 
accessing the Internet by using the formula:

Total of Internet browse time for user x cost 
entered = individual cost
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Top N
All Internet Browse Time charts return Top N data. Top N is the number of 
objects reported in top reports (such as Top By Hits), where N is the number 
of objects you select in the Report Criteria dialog box.

For Internet Browse Time charts, the total of the report includes only the Top 
N. All other report types report the total as the Top N value plus all others. 

Ads and miscellaneous sites not included
To provide the most accurate measure of the time users spend browsing the 
Internet, the Internet Browse Time reports do not include hits to ads and 
miscellaneous sites. For ads, these sites may sometimes be the embedded 
links at various sites. Some web-based applications do automatic lookups of 
other sites. If such ads and miscellaneous sites were included in Internet 
Browse Time reports, they would inflate the reported time users spent 
browsing.

Therefore, if a user accesses www.cnn.com, which spawns the ad, http://
ad.trafficmp.com/thisad/content/sellmoreproduct/product.html, the Internet 
Browse Time report for this user does not reflect the time spent browsing the 
ad. It reports only the time spent at www.cnn.com.

Running reports from the command line in Reporter

Websense Reporter offers a command-line capability that lets you generate 
reports without opening the Reporter window. Perform these activities 
manually by entering the command at the time you want to create the report 
file. By using a Windows scheduling service, you can export data or generate 
reports at scheduled times and days.
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Command-line flags
The Websense Enterprise Reporter commands let you specify the criteria 
necessary to generate reports. Use these command-line flags to set criteria for 
generating reports.

Descriptions of the available command-line flags appear below. Unless 
otherwise noted, all flags must be followed by an appropriate value.

Note
Use the full file name to generate the report from the 
command line. If there are spaces in the file name, then the 
name must be contained within double quote marks (“) in 
the command.

Flag Action

-r Generate a Summary or Detail report. This flag does not take a 
value, and cannot be used in the same command as the -a flag. 
The -x flag must be included in an -r command. 

-n Generating Reports: The favorite file name, as it appears in the 
Favorites subdirectory in the Reporter directory. 

-f Start date for the time period to be reported (for example: -f 1/1/
2007). This flag must be used in conjunction with the -t flag.
If there is no date range in the command, Reporter generates a 
report using dates available in the selected Log Database.

-t End date for the time period to be reported (for example: -t 11/11/
2007). This flag must be used in conjunction with the -f flag. 
If there is no date range in the command, Reporter generates a 
report using all dates available in the selected Log Database.

-s Set a date range. This flag cannot be used in the same command 
as the -f or -t flags. Available values for this flag include:

Dx = time in days
Wx = time in weeks
Mx = time in months

Replace x with the number of days, weeks, or months you want 
to report on (for example: -s D3). Reporter starts with the current 
system date, and works back the indicated number of days, 
weeks, or months.
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Generating reports
Generate reports from the command line after saving them as Favorite files.

1. Create a Favorite file with the report criteria. The following steps 
summarize the procedure.
a. Select a report by double-clicking it in the Workspace pane.

-d Complete path to the directory for saving the generated report.

-x Export format of the report. This flag must be used in the same 
command as the -r flag.
Specify the report format with 1 of the following.

CHR = Character Separated Values
CSV = Comma Separated Values
HTML32 = HTML 3.2 Standard
HTML40 = HTML 4.0 DHTML
PTEXT = Paginated Text
RTEXT = Rich Text Format
TEXT = Plain Text
TSV = Tab Separated Values
TTEXT = Tab Separated Text
WORD = Microsoft Word for Windows 2.0 and      higher (do 
not use for exporting charts)
XL7 = Microsoft Excel 7.0
XL8 = Microsoft Excel 8.0 (XLS) (recommended for tabular 
reports only)

-j Identifies a specific job that you choose to run.

-init No longer available - trend queries run as Daily Job.

-start No longer available - trend queries run as Daily Job.

-end No longer available - trend queries run as Daily Job.

-all No longer available - trend queries run as Daily Job.

-disposition No longer available - trend queries run as Daily Job.

Flag Action
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b. Enter report settings in the Report Criteria dialog box.

c. Click Save as Favorite at the bottom of the Report Criteria dialog 
box.

d. Enter a name for the report. This report name appears on the Favorites 
list in the Workspace pane. 

e. Click OK. 
2. Select a Log Database for Reporter to generate reports from.

a. Select Options from the Tools menu. A Select Data Source dialog 
box appears.

b. Select the Machine Data Source tab.
c. Highlight the Data Source Name created for use with the Log 

Database.
d. Click OK. A SQL Server logon dialog box appears. 
e. Enter the Logon ID and Password you established for this database 

in your database engine. Use the same logon ID and password for all 
databases, or establish different user logon IDs and passwords for 
different databases.
If you are not using a trusted connection for database 
communications but the Use Trusted Connection option is checked, 
uncheck it and enter the appropriate logon ID and password.

f. Click OK. Reporter is now ready to generate reports from the 
selected Log Database.

3. Close the Reporter window, as reports cannot be generated from the 
command line while Reporter is open.

4. Open a command prompt window. 

Note
Date settings made in the Report Criteria dialog box are 
not used when generating reports from the command line. 
Date settings must be entered at the command line.
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5. Change to the Reporter directory where the Reporter.exe is located.

6. Enter a command to generate and export the report. For example:
Reporter.exe  -r  -n  WSFavReport.1  -f  1/1/2005   
-t  11/11/2006  -d  C:\Reports\TestRpt.xls  -x  XL8

This command would generate a report on Internet access information 
logged between January 1, 2005 and November 11, 2006. It would be 
named TestRpt.xls, and then exported as an Excel document to a 
directory called Reports, located on the C drive.

If there is no date range entered in the command, Reporter generates a report 
using all dates available in the selected Log Database. 

Generating Favorites

When you have defined a report in Reporter that you would like to generate 
again, save it as a Favorite and generate that report definition for later use. 
The saved report definition is called a Favorite and will be listed in the 
Favorites report type.

Reports have to be saved as Favorites before they can be run on a scheduled 
basis.

Using Favorites
Saving report definitions as Favorite files also allows you to:

quickly and regularly generate a specific report(s) without having to take 
time to go through the criteria selection process again
generate reports from the command line in Reporter (see details discussed 
in Running reports from the command line in Reporter, page 45)
schedule reports to run at a later time (see details discussed in Scheduling 
Reporter reports, page 71)

Note
Generate reports from any directory by placing Reporter 
on the system path. For details on working with the system 
path, see the Windows documentation.
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Creating Favorites
When you have selected a report in Reporter, you have the option of saving a 
report as a Favorite.

1. Select a report by double-clicking it in the Workspace pane. A Report 
Criteria dialog box appears.

2. Enter report settings in the Report Criteria dialog box. 

3. Click Save as Favorite at the bottom of the Report Criteria dialog box. A 
Report Name dialog box appears.

4. Enter a name for the report. (Report names cannot exceed 200 characters, 
including spaces.)

5. Click OK. This report name appears on the Favorites list in the 
Workspace pane, and becomes the file name used in the Reporter 
directory. 

Reporter saves the favorite as a .fav file in the Websense Enterprise Reporter 
directory (for example Human Resources Monthly Report.fav). 

View the file name by right-clicking the report in the Favorites folder of the 
Workspace pane, and selecting View File Name. 

Generating reports from Favorites
Generate reports from Favorites saved in Reporter.

1. Double-click the name of the Favorite in the Favorites folder in the 
Workspace pane. A Report Criteria dialog box appears with the 
established Favorite Report settings.

2. Edit the current report.
3. Click Generate to create the report.

Note
Date settings established in the Report Criteria dialog box 
are not used for reports generated by the Scheduled Jobs 
feature or from the command line.
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Modifying Favorites
Modify Favorites saved in Reporter.

1. Double-click the name of the Favorite you want to modify. The Report 
Criteria dialog box appears.

2. Make changes, as needed, and click Save as Favorite. A Report Name 
dialog box appears, displaying the current report name. 

3. Retain the existing report name to modify the existing report definition. 
Enter a new report name to save the settings as a new Favorite (the 
existing Favorite remains unchanged).

4. Click OK.

Deleting Favorites
Favorites that have been used in scheduled jobs cannot be deleted. Other 
Favorites can be deleted if they become obsolete.

1. Right-click the name of the Favorite you want to delete.
2. Select Delete from the shortcut menu that appears.
3. Click Yes in the confirmation message box to delete the Favorite file.

Scheduling Favorites
You can run selected reports on a repeated basis, at a specific time with the 
Scheduled Jobs feature. These reports can be emailed to selected recipients. 

For information on scheduling report jobs for Reporter, see Chapter 3: 
Exporting, Scheduling, and Printing Reports in Reporter.

Examples of Reporter reports

Example 1: Activity in the Spyware category
Example 2: Determining liability risk for your company
Example 3: Determining money lost by your company
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Example 1: Activity in the Spyware category
You may find it particularly useful to find out whether there has been any 
activity in the Spyware category. 

You can set up a report in Reporter to run every week to check on the Spyware 
category. This report can be emailed to you.

1. Websense Enterprise and Websense Enterprise Reporting need to be 
installed.

2. Make sure that you have purchased the Security Premium Group, or have 
signed up for the free evaluation at http://www.my.websense.com.

3. Launch Websense Enterprise Reporter from the Windows Start menu: 
Programs > Websense > Websense Reporter.

4. Locate the User Activity Detail report in the Management reports.

User Activity Detail report
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5. Double-click on this report and select the Categories/Risk Classes tab.

6. Click Deselect All to deselect all categories.
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7. Select only the Spyware category.

8. Click Save as Favorite.
9. Type a report name, such as Spyware Report and click OK.
10. Select the Scheduler icon in the Reporter menu at the top, and then click 

New. The Job Scheduler Wizard appears.
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11. Type a name for the new spyware report and select the frequency with 
which you would like it emailed to you. Click Next.

12. Select the day you would like the report to run. Click Next.
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13. Select the date range for the report. Click Next.

14. Select the time of day for the report to run. Click Next.
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15. Select the Favorite that you generated, and then click > to generate it 
according to the schedule that you just defined.

16. Make sure the Favorite report that you defined is in the list to be 
generated. Click Next.
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17. Select the delivery options. Click Next.

18. Add the names of the email recipients for the report, and click > to add 
them to the distribution for the report you just scheduled. Click Next.
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19. Select the options for the email that will be sent when the report is 
generated. Click Next.

20. Check the summary of the choices you have made for the scheduled 
report. If they are correct, click Finish. If you want to make changes, 
click Back.

21. The new job that you scheduled is now displayed in the Scheduled Jobs 
dialog box. Click Close.

22. Enter the name of your SMTP server (mail server).

Note
Make sure your email system administrator has set a large 
enough email size limit. Otherwise, some large reports 
may not be delivered properly via email.

IMPORTANT
In order for scheduled jobs to run, Websense Enterprise 
Reporter must not be running.
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Example 2: Determining liability risk for your company
When your employees access certain types of sites, it may increase the risk 
that your company will be held legally responsible for actions such as sexual 
harassment.

To determine your risk level you must understand the Internet traffic patterns 
of your employees. Reporting on the most-used sites according to their 
categorizations in the Websense Master Database is an easy way to identify 
what types of sites employees are visiting. Once you identify these sites, you 
can assess your corporate liability risk and change access policies, if needed.

The Top Categories by Hits report helps you determine if your company 
Internet acceptable usage policy is adequate, or if changes need to be made. 
By default, you review all traffic to determine if additional categories should 
be managed. Also, you may modify the report criteria to display only blocked 
traffic to determine the level of traffic that is inconsistent with your acceptable 
Internet usage policy enforced by Websense.
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Interpreting the report
In the report example, the top 10 most visited categories are shown. You can 
check to see if there are hits that have been logged to Adult Material: Adult 
Content sites. These sites may contain adult material and may increase your 
organization’s risk of legal liability in a sexual harassment-related situation. 

Acting on report results
Drill down to specific detail underlying risk areas by narrowing your selection 
to a subset or single category, such as Adult Material. Use additional reports 
to learn about the specific URLs accessed and users or departments initiating 
the access. Modify your corporate usage policies accordingly, and fine-tune 
Websense policies in line with them.

Related reports
Websense Reporter offers additional reports that will help you analyze the 
data reported by the Top Categories by Hits Report:

Management: Category: Top by Hits: Lists the most frequently accessed 
sites within specific categories. 

Management: User: Top By Hits: Determines the Internet users that are 
primary contributors to liability risk.

Management: User: Top by Internet Browse Time: Displays a chart of 
users with the largest amount of time spent accessing the Internet.

Example: To run the Top Categories by Hits Report:

1. In the Reporter Workspace Pane, double-click the Management > 
Category > Top by Hits report. 
In the Report Criteria dialog box, establish the settings for each tab, such 
as date range and lists of available protocols. Select a tab to display its 
options. For more information on establishing report criteria, see 
Choosing report criteria, page 17.
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2. After establishing criteria for a particular report, save the settings for 
future use by clicking Save as Favorite on the Report Criteria dialog box 
before generating the report.

3. Click Generate to create the report. Reporter evaluates the Log Database 
to identify entries that meet all selected report criteria. 

Example 3: Determining money lost by your company
Websense Enterprise Reporter can be a useful tool for gathering and analyzing 
data on employee Internet use, potentially saving your company hundreds of 
thousands of dollars that would have been lost productivity. You can 
determine how much of your company’s money is lost on non-business-
related Internet usage.

Note
Combine report criteria selections carefully to avoid 
defining an empty report.
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The Internet Browse Time report shows the total amount of time employees 
spent surfing categories of websites, ranging from entertainment to online 
gaming to adult content.

Interpreting the report
This type of report can tell you important information about employee 
Internet use — loss of employee productivity and its cost to your company.

Note that in the sample report, this department spent more than 40 hours 
browsing the Internet. A large percentage of the surfing was non-work-
related, such as visits to adult content, drugs, entertainment, and gaming 
websites.

At an average cost of $40 per hour for wages, a department of users trimmed 
more than $1,600 from your company’s bottom line in 1 workday. Factored 
over the course of 1 year, the amount grows to more than $400,000.

Acting on report results
Make sure Websense Enterprise is configured to block or manage access to 
non-work-related websites, such as adult sites and games. Run other related 
reports to drill down to the details.
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Related reports
Management: Top Destinations by Internet Browse Time: Shows the sites 
where your employees are spending the most time.

Management: Internet Browse Time by User: Lists the users that are 
accessing sites in each category.

Example: To run the Internet Browse Time report:

1. In the Reporter Workspace Pane, double-click the Management > User > 
Internet Browse Time Summary report. 
In the Report Criteria dialog box, establish the settings for each tab, 
such as date range, lists of available protocols, and so on. Select a tab to 
display its options.

2. Enter a Cost on the Customize tab.
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3. Click Generate to create the report. Reporter evaluates the Log Database 
to identify entries that meet all selected report criteria. 

After establishing criteria for a particular report, save the settings for future 
use by clicking Save as Favorite on the Report Criteria dialog box before 
generating the report.

Note
Combine report criteria selections carefully to avoid 
defining an empty report.
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CHAPTER 3 Exporting, Scheduling, and 
Printing Reports in Reporter
Searching the Reporter report data
Sorting information in Detail Reporter reports
Exporting Reporter reports
Scheduling Reporter reports
Scheduling Reporter reports using the command line
Printing Reporter reports

Searching the Reporter report data

Depending upon the criteria established, reports can be long. You can search 
reports for specific information, such as a user name or date.

Enter the text or numeric information of interest in the 
search field on the Report pane toolbar, and then click the 
Search button.

Reporter searches the report, starting from the current page, and highlights 
information that matches the search criteria. Continue clicking the Search 
button to find each instance of the selected information in the report.

IMPORTANT
If a search results in a report with highlighted blank fields, 
click the Search button to find the search criteria.
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Sorting information in Detail Reporter reports

Initially, Detail reports are generated with a predetermined organizational 
structure. Sorting the information in these reports customizes the order of 
report data to suit the needs of your organization.

1. Generate a Detail report.
2. Select Sort from the Report menu. The Sort Criteria dialog box that 

appears offers options for sorting information according to the data in the 
selected columns of the report.

3. Select Primary and Secondary columns to sort from the drop-down lists. 
The columns in the selected report determine options in these lists. 

4. Select Ascending or Descending order.
Reporter uses the first character of each object to sort data. For example, 
if sorting IP addresses in descending order, an IP address beginning with 
the number 2 would come before an IP address beginning with the 
number 10, since Reporter only looks at the 2 and the 1.

5. Click OK to sort the report according to your selections. The new report 
replaces the original report in the Report pane.

Note
When sorting according to time, Reporter sorts for hours, 
minutes, and seconds. The displayed report, however, only 
reflects hours and minutes. As a result, when you sort for 
time, your report may show several times that appear to be 
the same. 
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Exporting Reporter reports

Exporting reports in Reporter to a file or application makes them accessible to 
individuals in your organization who are not running Websense Enterprise 
Reporter. 

1. On the Report pane toolbar, click the Export button.
2. Select a Format from the list in the Export dialog box that 

appears. 

Character-separated values: Creates a text file that separates each 
report value with the character you select. These files are suitable for 
import into various spreadsheet programs. When prompted, leave the 
Same number formats as in report option unchecked, or you may 
receive formatting errors.
Comma-separated values: Separates each value in the report by a 
comma. This format is suitable for importing the report into 
spreadsheet programs.

IMPORTANT
When reports are exported to an Excel file, the numbers 
are changed to character strings in order to support 
regional settings.

To use the exported Excel file as a spreadsheet, change the 
number character strings back to numbers inside Excel.

Note
Your export format choices will vary, depending on the 
applications that you have installed on the machine.

Depending on the .dlls which reside on your hard drive, 
you may see numerous other export options in the drop-
down list. The following list of formats are the only 
formats supported by Websense.
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Excel: Creates a file that can be imported into Microsoft Excel 
version 7 or version 8 (recommended for tabular reports only). Be 
aware that bitmap files, such as a company logo, will be omitted from 
the exported file. For the best results, do not select an Extended Excel 
format.
HTML (3.2 Standard or 4.0 DHTML): Select the version 
compatible with the browsers used to view the report. Keep in mind 
that reports in HTML format display most quickly in Internet 
Explorer v5.5 or later.
Paginated Text: Creates an ASCII text file with page breaks inserted 
after the number of lines you specify. 
Rich Text Format: Creates an RTF file that can be opened in various 
word processors.
Tab-separated text: Creates a text file with a column of headings and 
totals with each value enclosed in quotes and separated by a tab.
Tab-separated values: Creates a text file with each report value 
enclosed in quotes and separated by a tab.
Plain Text: Creates a continuous ASCII text file for importing into a 
text editor.
Word for Windows document: Creates a file formatted for import 
into Microsoft Word 2.0 or higher. (Do not export charts to Word for 
Windows format.)

3. Select a Destination from the list. Destinations comprise the locations to 
which reports can be exported. Available destinations are as follows:

Application: Open the report in a program compatible with the 
selected export format. For example, a report exported as a Word for 
Windows document would open in a Microsoft Windows application.
Disk file: Save the report to any directory on your machine.

4. Click OK to export the report.
Depending on the format and destination you selected, you may be asked 
for additional information, such as the number of lines per page for a 
Paginated Text file. Supply the requested information and click OK.
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To cancel the export for any reason, click Cancel (do not click x in the top 
right corner).

After you supply the required information, Reporter generates a file in the 
requested format, at the specified location. Use a browser or other appropriate 
application to view and manipulate the data.

Scheduling Reporter reports

You can schedule 1 or more Reporter reports to generate at regular intervals, 
and then email them to others or save them to a directory on the Reporter 
machine. Use the Job Scheduler Wizard to set up and maintain report 
schedules. Alternatively, you can schedule reports to generate from the 
command line.

1. Open the Tools menu, and then select Scheduled Jobs to open the 
Scheduled Jobs dialog box.

2. Click SMTP, enter the name or IP address of the SMTP server that will be 
used to email reports and job notifications, and then click OK.

Note
For Paginated Text files, set the number of lines per page 
to a value greater than 1 to produce the best results.

Note
Make sure your email system administrator has set a large 
enough mailbox size limit on your network’s email server. 
Otherwise, some large reports may not be delivered 
properly via email.
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3. Click New in the opening dialog box to create a new job. The Job 
Scheduler Wizard appears.

4. Establish a Name for this job, and select the frequency (once, daily, 
weekly, or monthly) for this job to run, and then click Next.

5. Select options appropriate to the frequency selected, and then click Next.
Once: Enter the date for running the job.
Daily: Enter the number of days before the job repeats.
Weekly: Enter a number of weeks before the job repeats, and select 
the day(s) of the week on which it runs.
Monthly: Enter the number of months before job repeats, and select 
the day(s) of the month on which it runs.

6. Set the time period the reports will cover, and then click Next. 

Note
The time period defined in the Job Scheduler Wizard 
overrides the time period established in the Report Criteria 
dialog box.
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These settings are based on the date the reports run. For example, 
selecting the last 2 weeks means that each time the job runs, it prepares 
reports for the 2 weeks preceding the run date.

7. Enter the time at which the job should begin, and then click Next.
Depending on the size of the Log Database, a single report may take 
several hours to generate. Consider scheduling reports to run during an 
off-peak time, such as after work hours.

8. Select the reports for this job, and then click Next. 
The dialog box lists all favorites you have saved. Use the arrow keys (< 
and >) to move selected Favorites into or out of the Generate list. Use the 
double arrow keys to move all reports between the 2 lists.
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9. Select output options for the completed reports, and then click Next.

Email generated reports: Check this option to send the completed 
reports to selected recipients via email.
Send Email notification: Check this option to send a selected 
recipient an email message when the job is complete.
Delete local copy: Check this option to delete the reports on the 
Reporter machine after they are sent via email. Uncheck this option to 
keep the reports on the local machine.
Use Favorite name/Overwrite: Check this option to have the 
completed report files use the same name as the Favorite file. 
Subsequent jobs will overwrite the existing report files with the new 
reports.
Path: Click Browse and select a path for creating or storing the 
completed reports.

Uncheck this option to have each job create report files with unique 
file names (the favorite name followed by a unique number).
Export format: Select the file format for the completed reports. 

Note
Do not create or store reports in the Reporter/Favorites 
directory. 
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10. To email the completed reports or send a notification, select recipients and 
click Next. The options available differ, depending on whether you 
selected to email the reports or send only a notification.

Email Notification Only: To send email notification when the job is 
complete (but not to email reports), enter the email address.
Email Reports: To email the reports (with or without email 
notification), a dialog box lists any email addresses previously added 
through the Job Scheduler Wizard. 
New: To add new addresses to the list of potential recipients (on the 
left). 
Delete: To delete selected addresses from the list of potential 
recipients (on the left).
Arrows (< and >): Click the appropriate arrow to move the selected 
address into or out of the list of recipients for this job (on the right).

11. To email reports, create the email message to accompany the reports and 
click Next. This option appears only if you chose to send the completed 
reports via email.

Subject: Accept the default of the job name, or enter an alternate 
subject for the email message.
Body: Enter text appropriate to all report recipients each time the job 
runs.
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From: Select the email address from which the reports are sent. If an 
email notification is being sent when the job is complete, the address 
entered in this field will receive the notification message.

12. Review the job definition that appears and click Finish to save the job and 
return to the opening Job Scheduler dialog box.

13. Create additional new jobs, edit existing jobs, or delete jobs as needed. 
When you are done, click Close.

14. Close the Reporter window before the job’s scheduled start time, but 
leave the machine running. 

Websense recommends that you set up the Report Scheduler service to run as 
a user with administrative privileges. You can modify the service in the 
Administrative tools in the Windows control panel.

Scheduling Reporter reports using the command line

You can generate reports in Reporter on a regular basis in an unattended 
command-line mode by using available Windows Services. First create a 
batch file with 1 Reporter command for each report to be created. Then set up 
a schedule, as described for the Windows 2000 Scheduled Tasks.

Windows 2000 Scheduled Tasks
Windows 2000 users can run a batch file containing Reporter commands at 
regular intervals using the Windows Scheduled Tasks application. The 
Scheduled Tasks application schedules and initiates programs to run at 
selected times and days.

1. Create a batch file as follows:
a. Enter the following command to create a batch file:
edit report.bat

IMPORTANT
Scheduled jobs can start only if the Reporter machine is 
running and the Reporter window is closed.
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Replace report with a descriptive file name that meets your 
organization's naming conventions, but be sure to retain the .bat 
extension.

b. Enter commands, as described in Column descriptions in Reporter, 
page 38, for generating reports. Each command must start on a new 
line.

c. Save the file.
2. From the Windows Start menu select: Programs>Accessories>System 

Tools> Scheduled Tasks.
3. Select the batch file you just created from the list.
4. Set days and times for the batch file to run.

Printing Reporter reports

Websense Enterprise Reporter lets you print any report open in the Report 
pane.

1. Select Print Setup from the File menu. A Print Setup dialog box displays 
options appropriate to your printer. The options vary, according to your 
network setup.

2. Select a printer and set other options, as needed.
3. Click OK.

Note
Using the –s flag to establish a date range allows you to 
generate reports without updating the batch file. 

IMPORTANT
Changes in network topology, such as the addition of new 
workstations or users, may require that you edit report 
criteria in the Favorite file to properly reflect the current 
user environment.
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4. Click the Print button on the Report pane toolbar of the selected 
report.
A Print dialog box appears.

5. Indicate which pages to print, the number of copies, and whether you 
would like the pages collated.

6. Click OK to print.
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The database for v6.3 must be attached to the database engine. For 
information on how to attach a database, see the Microsoft documentation.

Changing the database

Websense Reporter must be connected to a database through an ODBC 
connection in order to generate reports. An ODBC connection is established 
during installation. You may need to manually create an ODBC connection to 
view an old database.

The database can be maintained on a different machine than the database 
engine. The Reporter machine must be able to communicate with the database 
via an ODBC connection.

Websense Reporter views the catalog database and the database partitions, 
which have been selected in Database Administration.
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APPENDIX A Risk Classes
The Websense Master Database organizes Internet sites (by IP addresses and 
their associated URLs) into 1 of approximately 90 major categories and 
subcategories. 

Most Websense categories have been associated with a potential risk, and are 
identified in a specific Risk Class. Some categories are in more than 1 Risk 
Class.

This is the list of current Risk Classes of Internet activity and a brief 
description of each.

Risk Class Description

Network Bandwidth Loss This activity may degrade network performance because of 
increased traffic in size or number of files transferred.

Legal Liability This activity may be associated with increased legal risks for the 
employee and corporation.

Productivity Loss This activity may be associated with loss in employee 
productivity.

Security Risk This activity may cause a risk for network or corporate security.

Business Usage This activity may be considered business or job-related.
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The following table shows how the Risk Classes map to categories. This 
mapping between Risk Classes and categories can be changed in Websense 
Manager.

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage

Abortion

Pro-Choice

Pro-Life

Adult Material

Adult Content

Lingerie and 
Swimsuit

Nudity

Sex

Sex Education

Advocacy Groups

Bandwidth PG 
Manages Access 
to:

Internet Radio 
and TV

Internet 
Telephony

Peer-to-Peer File 
Sharing

Personal 
Network Storage 
and Backup

Streaming Media
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Business and 
Economy

Financial Data 
and Services

Drugs

Abused Drugs

Marijuana

Prescribed 
Medications

Supplements and 
Unregulated 
Compounds

Education

Cultural 
Institutions

Educational 
Institutions

Educational 
Materials

Reference 
Materials

Entertainment

MP3

Gambling

Games

Government

Military

Political 
Organizations

Health

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage
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Illegal or 
Questionable

Information 
Technology

Computer 
Security

Hacking

Proxy Avoidance

Search Engines 
and Portals

URL Translation 
Sites

Web Hosting

Internet 
Communication

Web Chat

Web-based 
Email

Job Search

Militancy and 
Extremist

Miscellaneous

Content Delivery 
Networks

Dynamic 
Content

File Download 
Servers

Image Servers

Images (Media)

Network Errors

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage
84 W Websense Enterprise Reporting



Appendix A: Risk Classes
Private IP 
Addresses

Uncategorized

News and Media

Alternative 
Journals

Non-HTTP

Productivity PG 
Manages Access 
to:

Advertisements

Freeware and 
Software 
Download

Instant 
Messaging

Message Boards 
and Clubs

Online 
Brokerage and 
Trading

Pay-to-Surf

Security PG Blocks 
Access to:

Sites associated 
to:

Keyloggers
Malicious 
websites

Phishing and 
other frauds

Spyware

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage
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Malicious 
Mobile Code

Racism and Hate

Religion

Non-Traditional 
Religions and 
Occult and 
Folklore

Traditional 
Religions

Shopping

Internet Auctions

Real Estate

Social 
Organizations

Professional and 
Worker 
Organizations

Service and 
Philanthropic 
Organizations

Social and 
Affiliation 
Organizations

Society and 
Lifestyles

Alcohol and 
Tobacco

Gay or Lesbian 
or Bisexual 
Interest

Hobbies

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage
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Personal 
websites

Personals and 
Dating

Restaurants and 
Dining

Special Events

Sports

Sport Hunting 
and Gun Clubs

Tasteless

Travel

User-Defined

Vehicles

Violence

Weapons

Network 
Bandwidth 
Loss

Legal 
Liability

Productivity 
Loss

Security 
Risk

Business 
Usage
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